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Lab 03 – Compiling RPG 
 

Overview 
 

This module teaches you how to verify and compile RPG programs and use the error list in the Remote 
System Explorer.  When errors are found by either the verify or the compile step, the Error List appears. 

The Error List is a powerful tool that manages errors found by the verify and compile utilities.  You will 
become familiar with these tools, the various capabilities of the Error List and the RPG program that you 

have created. 

Learning objectives 
 
After completing these exercises, you should be able to accomplish the following tasks independently: 

 

• Check for semantic errors in a source member on your workstation 

• Start the Program Verifier tool 

• Use the Error List to locate each error in the source 

• Use content-assist to fix an error 

• Save your source 

• Re-verify source 

• Change compile preferences 

• Invoke the compile command 

• Change the current library using the Command field in the Object Table view 

• Start an interactive connection 

• Invoke the Payroll program 

Skill level and prerequisites 
 
Introductory. 

 

 

Important! 
 

You should complete RDi Lab01 ‘Getting started’ before you work on this lab.  Lab01 
contains the following information and instructions: 

• Which IBM i server to connect to 
• Which User ID to use 
• How to start RDi, create a connection and connect 
• How to setup the correct library list for this lab 

 
Knowledge of basic Microsoft Windows operations such as working with the desktop, mouse operations 

such as opening folders and drag-and-drop is assumed.  It will also be helpful if you understand DDS and 
ILE RPG. 
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Conventions used in this workbook 
 
Bold font   is used to highlight user interface controls 

Mono-spaced font is used for user input text and code blocks 

Italic font   is used for variable names and glossary terms 

 
The following icons are also used to identify categories of information: 

 

Icon Purpose Explanation 

 

Important! 
This symbol calls attention to a particular step or command. 
For example, it might alert you to type a command carefully 

because it is case sensitive. 

 

Information 
This symbol indicates information that might not be necessary 

to complete a step but is helpful or good to know. 

 

Trouble-

shooting 

This symbol indicates that you can fix a specific problem by 

completing the associated troubleshooting information. 

 

Client System requirements 
 
The labs require IBM Rational Developer for IBM i (RDi) to be installed on your workstation. If you do 
not yet have this, you can download it for free from http://ibm.biz/rdi_trial.  

 

Host System requirements 
 

The easiest way to ensure you have everything you need, is to use the demonstration IBM i server that is 
set up and ready to use with these lab exercises. These labs use the RSELABxx library on that system. For 

those who want to run these labs on to their own system, you can load a SAVF with the RSELABxx 
library from rselabxx.savf. 
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1 Verify and compile using Remote System Explorer (RSE) 
 

1.1 Verifying the source 
 

Now you get to play with one of the most powerful and unique features of the Remote System Explorer, – 
the Program Verifier.  Before you compile your code on an IBM i system, you can make certain that there 

are no errors by invoking the Program Verifier. 
 

The verifier checks for semantic (compile) errors on your workstation so that you can guarantee a clean 
compile on your IBM i system.  Think of the host cycles you’ll save.  It is especially handy when you are 

writing code, but you are disconnected from a server.  You can do this because Remote System Explorer 
ported the parsing and checking code from the IBM i compilers to the workstation. 

 
The Error List view lists the errors that are found and their severity, displays the error messages directly 

within the source and helps you to navigate between the errors. 
 

To invoke the verifier: 
 
__1.  Expand the connection to your IBM i server and drill down to the member list in the 

QRPGLESRC source file in library RSELABxx, (do not use xx, 99 or 10, use the User ID 
number you were given) if your list in the RSE view doesn't show the member list already. 
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__2.  Open member PAYROLL in QRPGLESRC in the editor if it is not already open. 
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__3.  With the focus on the editor, click Source > Verify from the workbench menu. 
If the editor doesn't have focus click on the editor tab. 

 

 

Tip: 
Similarly, you can also use the context menu, right click the source 
member in the Remote Systems View, use the Verify tool button, 
or Ctrl+Shift+V - you need the source in the editor for the tool bar 
button to be visible. 

 

 
After a moment the verifier will display an Error List below the Editor window. 
 

The error list shows you: 
__a.  The error messages 

__b.  The severities of the errors 
__c.  The line numbers 

__d.  The source locations 
__e.  The connection names 

 

 
Next you will fix the errors in your source. 

 

The picture can't be displayed.
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__4.  Double-click the error RNF7030, for EMES not defined at line 365. 
 

 

You are automatically brought back into the Editor window to the line where the error occurred. 
The error on line 365 is a typo. 

 

 
The variable EMES should be EMESS.  One good way of finding the correct name is the content-

assist tool. 
 

 

Tip: 
The Outline view must be populated to use content-assist. 

 

__5.  Select the misspelled variable (double click on it) EMES if it is not selected already and press 
CRTL+spacebar to start the content assist tool. 

 

 

The selection presented contains the correct name. 
 

The picture can't be displayed.
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__6.  Double-click the variable EMESS in the list to correct the variable name. 
Another way to find the variable name is to use the Outline view and see what variables are 

declared. 
 

 
 

That was easy, let's fix the next error; it is a RNF7030 as well.  Go to the error list. 
 

 

Tip: 
In the error list, the source lines in error that you have changed already 

are displayed with a check mark in the prefix area.  This makes it easy to 

concentrate on errors you have not taken care of. 

 

__7.  Double-click RNF7030, showing RSNTAX not defined at line 95. 
 

 
Fix it in the editor. 

 
__8.  RSNTAX should really be RSNTAG.  Make the appropriate change. 

 

 

The picture can't be displayed.
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__9.  Go to the next error RNF5184. 
 

The next error is actually RNF7018 but it is related to the one you just fixed and already has a 
check mark and can be ignored.  It shows the same line number, which is an indication that both 

errors are related. 
 

__10.  Double-click RNF5184. 
 

 

 
__11.  Fix this by replacing the 2 with a 1. 

 

 

Error RNF7515 is related to the first error you fixed.  It has the same line number it already has a 
check mark.  You can ignore it.  The only serious remaining error is RFN5178.  This error is 

caused by a missing ENDSR. 
 

 

 

 

Tip: 
You can use the Show Block Nesting feature to find where the ENDSR 

is missing. 

The picture can't be displayed.
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Move your cursor to line 347, where the BEGSR statement is. Right-click and select Source > 
Show Block Nesting. 

You should see the block nesting of the current subroutine and that the ENDSR is missing before 
the next subroutine at line 404.  

 
__12.  Move to line 398 in the editor. 
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__13.  Remove the asterisk (*) from the C-spec. 
 

 

You can use the Tab key to quickly move to the appropriate column. 
All the non-informational errors are now fixed. 

You can filter out messages according to these severities by using the filter menu. 
 

 
 

__14.  Click the View Menu button in the Error List title bar. 
__15.  Click Show Severity on the pop-up menu. 

__16.  Uncheck severity type Information in the list. After this, all the information item in the error list 
disappears. 

 
__17.  You can save the member using one of these ways: 
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__a.  Click File > Save from the workbench menu 
 

 
 

__b.  Click the Save icon in the workbench toolbar: 
 

 
 

__c.  Press Ctrl+ S. 
 

Changes are uploaded to the IBM i system. 
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__18.  Verify your source again. 
 

Everything should be ok. Since the Information severity has been unchecked, you should not see 
any error message. You are ready to compile the program. 

 

 
 
You have verified your source and fixed any errors. 

 

1.2 Compiling source remotely 
 
The remote compile capability is part of the Remote System Explorer.  It gives you a workstation 

interface to submit requests to compile, bind, or build objects on the IBM i host.  It allows for easy access 
to all the compile options available for all the supported CRTxxx commands. 

 
If you used the local program verifier, then your host compiles should be successful -- no wasted IBM i 

cycles.  However, if there are errors, the host compiler will send the error information back to the 
workstation and they will be loaded into the Error List view, which behaves just as it did when you did a 

local verify. 
 

The default for compiling programs is to submit the compile to the batch job queue.  Here in this exercise, 
you can run the compile interactively. 
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To change the preferences to run the compile interactively: 
 
__1.  Click Window > Preferences from the workbench menu. 
__2.  In the left pane of the Preferences window, expand Remote Systems 

__3.  Expand IBM i under Remote Systems 
__4.  Click Command Execution under IBM i. 

__5.  In the right pane of the Preferences window, clear the Compile in batch check box 
__6.  Click OK to return to the Remote System Explorer perspective 

 

 
You will now use the prompt for the CRTBNDRPG command to specify your compile 

parameters.  All entry fields pertaining to names are already filled in with the correct information. 
 

To compile source: 
 

__7.  Right-click the PAYROLL member in QRPGLESRC. 
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__8.  Click Compile (Prompt) > CRTBNDRPG on the pop-up menu. 
 

 
 
The Create Bound RPG Program (CRTBNDRPG) dialog opens. 

 
__9.  In the Debugging views drop down list, select the *ALL parameter. 

If you want to see the other parameters available, click Advanced. 
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__10.  Click OK when you are finished. 
 

 
 

The progress bar on the workbench (bottom right corner) will indicate that the compile runs.  
Then the error list will be shown, with no errors, just information messages. 

You can also check the Commands Log view to verify that your program was created. 
 

__11.  Click the Commands Log tab at the bottom of the workbench. 
 

This log shows a list of all commands run on the remote system and the messages returned for 
each command. 

 

 
 

You have set compile preferences, invoked the compile command, and checked for a successful compile. 
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1.3 Submitting IBM i commands in the Object Table view 
 
You can use the Object Table view inside the Remote System Explorer to submit commands to the IBM i 

system.  You can run commands from the Commands field beneath the Object Table view, and view 
messages in the Messages field.  After you populate the table, you can enter a command and click either 
Prompt to specify parameters and then Run or just click Run. 
 

When you run a command, the Messages field is populated with the messages from the command.  When 
you select a message, the Details button is enabled.  When you click this button, the message and its help 

is displayed. 
 

Also note that besides the Object Table view, you can also use the Remote Systems view to run 
commands and programs.  Which one you choose depends on your personal preference.  In the Object 

Table view, you can see the properties of all items at the same time; they are displayed as rows across the 
table. 

 
In the Remote Systems view, you have greater ease of navigation; you can work from your Library list in 
the Objects subsystem, and you can see the contents of many items before selecting the one you want to 

run. 
 

In the Commands field, you select where you want to run the command. The choices are Normal, which 
means that the command will run in the RSE communication server job, Batch or Interactive. 

 
To change the library list: 

 
__1.  Click the Object Table view tab from the views at the bottom of the workbench. 

__2.  In the Command field type, CHGCURLIB RSELABxx (where xx is your User ID number). 
 

 

Tip: 
If you are not using an IBM supplied IBM i server, use a library that is on 

your own IBM i system. 

 

__3.  Click Run. 
 

 
 

The picture can't be displayed.
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Troubleshooting 
If the entry fields are disabled in the Object Table view, or you see an 

error message, activate a connection using one of the following steps. 

This happens because the Object Table view is not linked to an active 

connection and can’t determine where to run the command.  

 

 

If you encounter the problems described above, follow these steps to create a link to a connection: 
- Click OK. 
- In the Remote Systems view, right-click QRPGLESRC. 
- Click Show in Table on the context menu. 
This will show the members in the Object Table view and link the view to the connection. 

The command will run on the IBM i system and after it finishes you will see the completion 
message on the bottom of the Object Table view. 

 
Back in the workbench in the Remote Systems view: 
 

__4.  Right-click Library list. 
__5.  Click Refresh. 

 
You will see a small green asterisk beside the RSELABxx library to indicate it as your current 
library. 
 

 
 
You can also connect to other than IBM i systems with the Remote System Explorer and launch 
commands for these systems as well, for example, your local system, or Linux® 

 
You have submitted a command to change the current library in the command line of the Object Table 

view. 
 

The picture can't be displayed.
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Congratulations! 
 

You have successfully completed the RDi Lab 03 – Compiling RPG lab exercises. 
 

We recommend that you move on to the next lab in the sequence; or browse the list of labs on Rational 
Developer for i - Hands-On Labs at http://ibm.biz/rdi_labs to choose a lab of interest. 

 
More information, material and opportunities to discuss the product can be found at our RDi Hub:  

 
http://ibm.biz/rdi_hub 
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Appendix A  Notices 

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services currently available in 

your area. Any reference to an IBM product, program, or service is not intended to state or imply that only 
that IBM product, program, or service may be used. Any functionally equivalent product, program, or 

service that does not infringe any IBM intellectual property right may be used instead. However, it is the 

user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not grant you any license to these patents. You can send license 

inquiries, in writing, to: 

IBM Director of Licensing 

IBM Corporation 
North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 

Department in your country or send inquiries, in writing, to: 

IBM World Trade Asia Corporation 
Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES 

CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in 

certain transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically 

made to the information herein; these changes will be incorporated in new editions of the publication. 
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 

any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of 

the materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 

incurring any obligation to you. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
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been made on development-level systems and there is no guarantee that these measurements will be the 
same on generally available systems. Furthermore, some measurements may have been estimated through 

extrapolation. Actual results may vary. Users of this document should verify the applicable data for their 

specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products and 

cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those 

products. 

All statements regarding IBM's future direction and intent are subject to change or withdrawal without 

notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 

them as completely as possible, the examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names and addresses used by an actual 

business enterprise is entirely coincidental. All references to fictitious companies or individuals are used 

for illustration purposes only. 

COPYRIGHT LICENSE: 

This information contains sample application programs in source language, which illustrate programming 

techniques on various operating platforms. You may copy, modify, and distribute these sample programs 
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing 

application programs conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly tested under all 

conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these 
programs.
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Appendix B  Trademarks and copyrights 

The following terms are trademarks of International Business Machines Corporation in the United States, 

other countries, or both: 

IBM AIX CICS ClearCase ClearQuest Cloudscape  

Cube Views DB2 developerWorks DRDA IMS IMS/ESA  

Informix Lotus Lotus Workflow MQSeries OmniFind   

Rational Redbooks Red Brick RequisitePro System i   

System z Tivoli WebSphere Workplace System p   

 
Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or 

trademarks of Adobe Systems Incorporated in the United States, other countries, or both. 

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States, other 

countries, or both and is used under license therefrom. 

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United 

States, other countries, or both. See Java Guidelines 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in 

the United States, other countries, or both. 

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, 
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its 

subsidiaries in the United States and other countries. 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 

ITIL is a registered trademark and a registered community trademark of the Office of Government 

Commerce, and is registered in the U.S. Patent and Trademark Office. 

IT Infrastructure Library is a registered trademark of the Central Computer and Telecommunications 

Agency which is now part of the Office of Government Commerce. 

Other company, product and service names may be trademarks or service marks of others. 
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